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Introduction

This tutorial introduces the concepts of multiaxis machining, beginning with the
machine architecture and ending withmultiaxis toolpath creation. Multiaxis toolpaths
are basically the familiar contour, pocket, and surface toolpaths in X,Y, and Z, with rota-
tional motion added in A, B, and C. The available axes vary based on your particular
machine setup.

The workflow is consistent regardless of the multiaxis toolpath selected. Mastercam’s
Multiaxis interface follows a uniform structure through the toolpathing process. Select
the toolpath family, select a toolpath type, progress from top to bottom through the
tree-style interface, enter parameters on the necessary pages, and generate the
toolpath. Additional tools such as Mastercam Simulator andMachine Simulation allow
you to review your toolpath before cutting begins on the machine.

By completing this tutorial, you gain a general understanding of the multiaxis process.
The information contained in these pages gives you the knowledge and confidence to
work with Mastercam’s multiaxis toolpaths.

Tutorial Goals
l Understand the basic architecture of a multiaxis machine

l Review the controls of a multiaxis toolpath: cut pattern, tool axis control, and
tool tip control

l Follow the workflow of Mastercam’s Multiaxis toolpath interface

l Create andmodify a Multiaxis Curve toolpath

l Create andmodify a Multiaxis Drill toolpath

Introduction to Multiaxis Toolpath Requirements
l Mastercam 2018 with Mill or Mastercam Router

Introduction to Multiaxis Toolpaths— Introduction



WARNING: Screen colors in the tutorial pictures were modified to enhance
image quality; they may not match your Mastercam settings or the tutorial
results. These color differences do not affect the lesson or your results.

Estimated time to complete this tutorial: 1.5 hours

General Tutorial Requirements
All Mastercam 2018 tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operation system.

l The tutorials cannot be used with Mastercam Demo/Home Learning Edition.
The Demo/HLE file format (emcam) is different fromMastercam (mcam), and
basic Mastercam functions, such as file conversions and posting, are unavail-
able.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's
skills. We recommend that you complete them in order.

l Additional files may accompany a tutorial. Unless the tutorial provides specific
instructions on where to place these files, store them in a folder that can be
access from the Mastercam 2018 workstation, either with the tutorial or in any
location that you prefer.

l You will need an internet connection to view videos that are referenced in the
tutorials. All videos can be found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a
default metric or English configuration. The tutorial provides instructions for
loading the appropriate configuration file.

Introduction to Multiaxis Toolpaths— Introduction
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Basic Machine Overview

With a multiaxis machine, instead of a straightforwardmachine with XYZ
axes capabilities, you have a machine that can handle five or more axes of
motion. Typically, the axes are defined as XYZ/ABC/UVW as shown below.

The axes may be in a different orientation or have different relationships.
Your machine now has a much greater range of motion than a standard 3-
axis vertical or horizontal machine.

1



The addedmotion of a multiaxis machine enhances the capabilities of your shop, as
well as expands the variety of parts that you canmachine. Nearly every machine is
unique in its axes combination, orientation, travel and rotation limits, and controller.

Common terms for multiaxis machines are table/table, head/table, and head/head.
These terms describe the relationship of the rotary components on the machine. The
configuration of the rotaries determines the zero location of the machine and how you
need to locate the part within Mastercam. The part must be located in Mastercam
where it will be sitting on the machine. The only exception is for a head/head arrange-
ment.

CAUTION: Improper location of your geometry will cause the part to be cut
incorrectly.

Introduction to Multiaxis Toolpaths—1: BasicMachineOverview

8



9

Table/Table Machine
A table/tablemachine has both rotary axes connected to the table. Typically this is a
trunnion carrying a rotary table. The machine axes zero position is located at the inter-
section of rotary axes. Your part is located in Mastercam relative to the machine zero
position. The rotary components are shown in red in the following image.

Table/Table configuration with machine zero

Introduction to Multiaxis Toolpaths—1: BasicMachineOverview



Head/Table Machine
A head/tablemachine has one rotary on the table and the other on the spindle. They
operate independently of each other. The table could be comprised of a trunnion or
simply a rotary attached to the table. The machine axis zero is located at the inter-
section of the rotary axes. Your part is located in Mastercam relative to the machine
zero position, as in the table/table configuration. The rotary components are shown in
red in the following image.

Head/Table configuration with machine zero

Introduction to Multiaxis Toolpaths—1: BasicMachineOverview
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Head/Head Machine
A head/head machine has both rotary axes connected and attached to the spindle.
The machine axis zero is typically located on the face of the spindle. The origin is
shown on the table as this is where the spindle face lies when all axes are set to zero.
The rotary components are shown in red in the following image.

Head/Head configuration with machine zero

These are the basic arrangements of multiaxis machines. Be aware that multiaxis
machines may be as simple as a single rotary for 4-axis work, or as complex as having
five axes and a nutating head. Nomatter how the machine is configured, the inputs for
a good toolpath follow the same pattern frommachine to machine. Continue on to
Lesson 2 to learn about the necessary controls for creating an efficient multiaxis
toolpath.

Introduction to Multiaxis Toolpaths—1: BasicMachineOverview
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Multiaxis Toolpath Controls Overview

Three controls separate multiaxis toolpaths from the typical 2- and 3-axis
toolpaths:

l Cut Pattern

l Tool Axis Control

l Tool Tip Control

Effective use of these controls is the deciding factor in your ability to create
efficient toolpaths for your particular machine. This tutorial starts you on the
path to becoming a more effective programmer. However, there is no sub-
stitute for experience and knowing your machine’s capabilities.

2



Cut Pattern
What do you want the tool to follow? The answer is the cut pattern. Selecting a
toolpath family is the initial phase of establishing the cut pattern. Different toolpath
families vary the type of geometry allowed for the cut pattern. Geometry selection can
range from a contour or chain, to a surface edge or edges, and on through single or
multiple surfaces or solids. Below are two examples of cut pattern selections.

Curve Surface

In addition to the geometry selected for the toolpath, cut pattern includes such para-
meters as:

l Cuttingmethod: zigzag, one way, spiral

l Compensation: type and direction

Introduction to Multiaxis Toolpaths—2: Multiaxis Toolpath ControlsOverview
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l Stock to leave: drive surfaces, walls

l Stepover: across, along, increment

Subsequent lessons and tutorials cover cut pattern options inmore detail.

Tool Axis Control
How do you want the tool axis to behave as it follows the cut pattern? Tool axis con-
trol answers this question. Multiaxis toolpaths include numerous options on how to
manipulate the tool axis. The options allow you to control the part of the tool in contact
with the material, and the amount of tool movement the toolpath generates, as well as
being able to set the number of axes of output for the posted toolpath. Below are two
examples of tool axis control.

Surface

Introduction to Multiaxis Toolpaths—2: Multiaxis Toolpath ControlsOverview



From point

Toolpath family and toolpath type determine which tool axis controls you can access.
Some examples of the controls available include:

l Lines, surface, from point, chain

l Fixed angle to axis, be tilted relative to contact point

l Rotated around axis, from point

l Parallel to line, surface, plane

ClickHelp in Mastercam to find further details on the available options and their func-
tion.

Introduction to Multiaxis Toolpaths—2: Multiaxis Toolpath ControlsOverview
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Tool Tip Control
What controls the depth of the tool along the tool axis? Tool tip control handles this
function. Compensation surfaces are included in tool tip control. Applying tool tip con-
trol is a three step process:

1. Tool positions are generated along the selected cut pattern.

Introduction to Multiaxis Toolpaths—2: Multiaxis Toolpath ControlsOverview



2. Tool axis vectors are created at each position based on the tool axis control set-
tings.

Introduction to Multiaxis Toolpaths—2: Multiaxis Toolpath ControlsOverview
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3. Depth along the tool axis is applied based on the tip compensationmethod.

Note: Use the method depicted above when you have very complicated, or less than
perfect, part geometry. The clean core geometry is used to generate the cut pattern
and tool axis control vectors. Tip control is then used to cut the outer surfaces with
much cleaner motion.

The three controls described previously form the core of all your multiaxis toolpaths.
Additional refinement is added through collision control, linking, tool selection, and
more. Building confidence with these controls will greatly ease and enhance your abil-
ity to generate efficient multiaxis toolpaths. Continue on to Lesson 3 to see how these
controls are an integral part of the multiaxis workflow within Mastercam.

Introduction to Multiaxis Toolpaths—2: Multiaxis Toolpath ControlsOverview
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Mastercam Interface and Workflow

Mastercam’s Multiaxis toolpath interface follows the familiar tree-style lay-
out. You progress through the pages of the tree, make the necessary selec-
tions, enter appropriate parameters, and generate your toolpath. Viewing
the process in simplified terms helps to lessen the complexity of creating a
multiaxis toolpath.

Begin the toolpath creation process by selecting an appropriate machine
definition. This applies to all toolpath types in Mastercam. After selecting a
machine definition that supports multiaxis movement, choose aMultiaxis
toolpath. The following image shows the starting point for a Curve toolpath.

3



Multiaxis toolpaths are divided into two toolpath families, Pattern and Application.
Each toolpath family contains different toolpath types. Selecting the most efficient
type will come from experience and usage. For now, you focus on the general work-
flow rather than specific applications.

The tree structure provides the basic roadmap to creating a toolpath. While you can
select the pages as needed, the most efficient route is from top to bottom. Click the
plus sign before any page to expose additional pages for input.

The pages within the tree structure vary with the toolpath type. The procedure
remains the same regardless of what the tree looks like. If you can answer the fol-
lowing questions, you are well on your way to generating a multiaxis toolpath:

l What do I want the tool to follow?

l How do I want my tool axis to behave?

l What controls the depth along the tool axis?

Introduction to Multiaxis Toolpaths—3: Mastercam Interface and Workflow
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Cut Pattern Page
The controls discussed in the previous lesson are pivotal for multiaxis work. The cut
pattern page is where you select your drive geometry, set compensation parameters,
and set various other options. Below is a sample of the cut pattern page for a mul-
tiaxis Curve toolpath.

Introduction to Multiaxis Toolpaths—3: Mastercam Interface and Workflow



Tool Axis Control Page
The Tool Axis Control page defines the tiltingmotion of the tool axis as it moves along
the cut pattern. The options available vary by toolpath type, just as the tree structure
and other pages vary. Tool axis control is what sets multiaxis toolpaths apart from 2-
and 3-axis toolpaths. The ability to manipulate the tool axis allows for complex and
powerful control. Below is a sample of the Tool Axis Control page for a multiaxis Curve
toolpath.

Introduction to Multiaxis Toolpaths—3: Mastercam Interface and Workflow
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Collision Control Page
Tool tip control is found on the Collision Control page. Use the parameters to instruct
Mastercam how the tip of the tool should be placed in relation to the cut pattern.
Below is a sample of the Collision Control page for a multiaxis Curve toolpath.

Complete the remaining pages in the tree if necessary. Additional parameters include
linking information (how the tool moves when not in contact withmaterial) and rough-
ing options. The Additional Settings branch provides pages that generally do not need
to be touched for multiaxis programming. Review them, and click Help to learn details
about these pages. Continue on to Lesson 4 to begin creating a multiaxis Curve
toolpath.

Introduction to Multiaxis Toolpaths—3: Mastercam Interface and Workflow
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Multiaxis Curve Toolpath

Experience with design and toolpath creation is assumed at this point of the
tutorial. Detailed steps on such actions as selecting a machine definition,
changing the graphics view or construction plane, or making levels visible,
are not provided. Please review the Introduction to Mastercam tutorial
before continuing if you are not familiar with these concepts.

Lesson Goals
l Open a part file and assign a machine definition.

l Create a Multiaxis Curve toolpath.

l Backplot the toolpath.

4



Exercise 1: Getting Started with Toolpath Creation
Assigning a machine definition is the first step in creating a toolpath. Setting the graph-
ics view to allow the easiest geometry selection plays a part in visualizing your work.
This exercise guides you through the initial steps involved with creating a toolpath.

1. Start Mastercam using your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default metric configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the
System Configuration dialog box.

c. Choose ...\mcamxm.config <Metric> from the Current drop-
down list.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath
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d. ClickOK.

3. Open the part file Curve_Toolpath, which was provided with the tutorial.

4. If not already loaded, select the default Mill metric machine definition.

Note: The default machine definition has rotary axes defined that allowmul-
tiaxis toolpaths. Load the machine definition of your choice as long as it sup-
ports 5-axis motion.

5. Set your graphics view to Isometric.

6. Activate shading if necessary.

7. Fit the geometry to the screen using [Alt+F1] or Fit on the View tab.

8. Choose File, Save As, and save the part under a different file name. This pro-
tects the original tutorial file from being overwritten.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath



Exercise 2: Create a Multiaxis Curve Toolpath
Creating a toolpath involves selecting the toolpath type, tool, and geometry, as well as
completing the parameter pages. Completing this process yields a program capable
of cutting your part on a machine.

1. From the Toolpaths tab, chooseMultiaxis, Curve.

The Tool page opens.

2. Click Select library tool.

The tool library defined in the machine definition opens.

3. Click Filter, and set the filter to show only Endmill2 Sphere tools.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath
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4. Select the 8mm ball endmill and clickOK.

5. Select Cut Pattern from the tree view pane.

6. Choose 3D Curves from the Curve type drop-down selection.

7. Click Select points next to 3D Curves to return to the graphics window for
curve selection.

The Chaining dialog box displays.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath



8. Select the chain on the edge of the part as shown. The start position is not
important for the purpose of the tutorial. The chain should go in a clockwise dir-
ection, regardless of the start point. Click Reverse if necessary.

9. ClickOK in the Chaining dialog box to return to the Cut Pattern page.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath
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10. Set the remaining parameters as shown.

The radial offset value for this particular operation should equal the tool
radius. Use this field in a similar manner as a stock to leave. A value equal to
the tool radius is equivalent to zero stock to leave. Take advantage of this func-
tionality for trimming operations.

11. Select Tool Axis Control from the tree view pane.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath



12. Choose To point from the Tool axis control drop-down selection.

13. Click Select to return to the graphics window for point selection.

14. Select the point as indicated.

You return to the Tool Axis Control page.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath
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15. Set the remaining parameters as shown.

Note: Click in a field to see a progressive image on the right side of the page.
The image depicts what the field controls. ClickHelp for detailed information
on each field.

16. Select Collision Control from the tree view pane.

17. Set Vector depth to -10.0. The value allows the curve operation to trim the
part with the side of the tool, avoiding the ball portion at the tip.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath



The following images show how the difference between vector depth values
affects the toolpath.

Vector depth = 0.0

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath
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Vector depth = negative

18. Select Roughing from the tree view pane.

19. Ensure thatMulti Passes has been deselected.

Trimming operations using a Curve toolpath generally utilize a single pass.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath



20. ClickOK to generate the multiaxis curve toolpath on the selected geometry.

21. Save your part file.

Exercise 3: Backplot the Operation
Backplotting an operation allows you to review the tool motion before any cutting
takes place on the actual machine. Backplot should be the first step in validating your
toolpath.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath
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1. Click Backplot selected operations in the Toolpaths Manager.

2. In the Backplot dialog box, select Display tool andDisplay rapid moves.

3. ClickOptions in the Backplot dialog box.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath



4. Deselect the options shown and clickOK. This prevents your part from spin-
ning around andmoving out of view.

5. Click Play to begin the backplot of your toolpath.

6. ClickOK in the Backplot dialog box when you have finished reviewing the tool
motion.

Exercise 4: Machine Simulation
Machine simulation is the next step in validating your operations. The tool motion is
shown on your part as it is positioned on your machine. Collisions between various
machine components and the part are visually apparent, as well as reported in text on
the screen. The following is an overview of Machine Simulation. For a more detailed
explanation, reviewHelp, as well as the Machine Simulation tutorial.

1. On theMachine tab, click the dialog box launcher in theMachine Simulation
group.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath
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2. Select 6_5AXGEN_VMCHTAC from the drop-down list of machines.

The machine selection is saved with the part file. Running simulation on the
same part file will reload the selectedmachine.

3. Click Simulate to begin the machine simulation of the selected operation.

4. Use the simulation playback buttons to review the tool motion contained in
your operations. (If you do not see the part, clickWorkpiece, which is located
in the Simulation tab’s Visibility drop-down.)

5. Exit machine simulation to return to the Mastercam interface.

6. Save your part file. The same file will be used in a subsequent lesson.

You have now completed a basic multiaxis curve toolpath. Curve is generally used for
trimming operations. The motion is typically straightforward, making it an ideal
toolpath for demonstrating some different tool axis control strategies and the effects
they can produce on the tool. Proceed to Lesson 5 to explore these strategies.

Introduction to Multiaxis Toolpaths—4: Multiaxis Curve Toolpath
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Tool Axis Control Options

Tool axis control is what separates multiaxis toolpaths from normal surface,
chain, and point toolpaths. The ability to manipulate the angle of the tool, rel-
ative to the cut pattern, puts a great amount of control in your hands. The cut
speed, finish quality, and tool life can all be affected with tool axis control.
Complete this lesson to learnmore about two additional tool axis control
options for a multiaxis Curve toolpath.

Lesson Goals
l Open a previously saved part.

l Edit the operation’s parameters, specifically tool axis control.

l Generate the toolpath and observe the tool motion.

5



Exercise 1: Preparing the Part
1. Use File,Open to open the part file Curve_Toolpath_Lesson_5, which

was provided with the tutorial.

2. Set your graphics view to Isometric.

3. Activate shading if necessary.

4. Fit the geometry to the screen using [Alt+F1] or the Fit button.

5. Choose File, Save As, and save the part under a different file name. This pro-
tects the original tutorial file from being overwritten.

Exercise 2: Copy and Edit an Operation
1. Right-click on the first operation and hold the mouse button down.

2. Drag the operation to a position farther down the Toolpaths Manager.

3. Release the right mouse button and select Copy after.

Introduction to Multiaxis Toolpaths—5: Tool Axis ControlOptions
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4. Select operation 1 and turn off the toolpath display. Press T or click Toggle dis-
play on selected operations.

The visible toolpath belongs to operation 2.

5. Use the Levels Manager to make level 7:Chain visible.

The geometry on level 7 is used for tool axis control in this exercise.

6. In Toolpaths Manager, click Parameters under operation 2. The Multiaxis
Toolpath - Curve dialog box opens.

7. Select Tool from the tree view pane.

8. Enter Chain in the Comment box.

A comment helps to distinguish operations of the same toolpath type.

9. Select Tool Axis Control from the tree view pane.

Introduction to Multiaxis Toolpaths—5: Tool Axis ControlOptions



10. Choose Chain from the Tool axis control drop-down selection.

11. Click Select to open the Chaining dialog box.

12. Select the chain as shown, and clickOK in the Chaining dialog box.

Introduction to Multiaxis Toolpaths—5: Tool Axis ControlOptions
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13. In the Chain Options dialog box, select Closest point on chain, and clickOK to
return to the Tool Axis Control page.

14. ClickOK to accept the parameter changes.

15. Click Regenerate all dirty operations in the Toolpaths Manager.

16. Backplot the operation to observe the tool motion.

17. Save your part file.

At this point in the lesson, take a moment to review the two operations created. Oper-
ation 1 uses To point for tool axis control. The tool is always pointing at the selected
point. Operation 2 uses Chain for tool axis control. The tool is always pointing from a
point on the chain, in this case, the closest point of the chain. The different options cre-

Introduction to Multiaxis Toolpaths—5: Tool Axis ControlOptions



ate drastically different tool andmachine motion. The edge of the part will also have a
different taper depending on the tool axis.

Toggle the toolpath display for the two operations so that they are both visible. Notice
the different tool angle around the entire part shown below. Backplot the operations
to see the different tool motion. Select both operations and runMachine Simulation as
in the previous lesson. A collision is reported for operation 2 before you even run the
simulation. This indicates that using the existing chain for tool axis control is not going
to work on this particular machine. This does not indicate a bad toolpath; only the fact
that this toolpath will not run on the selectedmachine.

Exercise 3: Copy and Edit a Second Operation
1. Right-click on the second operation and hold the mouse button down.

2. Drag the operation to a position farther down the Toolpaths Manager.

3. Release the right mouse button and select Copy after.

4. Select operation 2 and turn off the toolpath display, by pressing T or clicking
the Toggle display on selected operations button.

The display for operations 1 and 2 are now both off.

Introduction to Multiaxis Toolpaths—5: Tool Axis ControlOptions
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5. Use the Levels Manager to make level 8:Tool axis lines visible. Turn off the dis-
play of levels 1, 6, and 7.

6. In Toolpaths Manager, click Parameters under operation 3. The Multiaxis
Toolpath - Curve dialog box opens.

7. Select Tool from the tree view pane.

8. Enter Lines in the Comment box.

9. Select Tool Axis Control from the tree view pane.

10. Choose Lines from the Tool axis control drop-down selection.

11. Click Select to open the Lines Tool Axis Control dialog box.

Introduction to Multiaxis Toolpaths—5: Tool Axis ControlOptions



12. ClickWindow select lines to select lines for tool axis control.

13. Draw a selection window around the entire part. Only lines are selected.

14. ClickOK in the Lines Tool Axis Control dialog box. You return to the Tool Axis
Control page.

15. ClickOK to accept the parameter changes.

Introduction to Multiaxis Toolpaths—5: Tool Axis ControlOptions

50



51

16. Click Regenerate all dirty operations in the Toolpaths Manager.

17. Backplot the operation to observe the tool motion.

18. Save your part file.

Review the tool motion for operation 3. Observe how the tool axis lines up with each
line as it approaches that point in the toolpath. The axis transitions from alignment
with one line as it moves to the next. Use as many lines as necessary to achieve the
desiredmotion.

Use Backplot andMachine Simulation to review the tool andmachine motion for all
three operations. The subtle differences in tool axis control put a great deal of power
in your hands for generating complex toolpaths. Tool axis control is a key element to
all multiaxis toolpaths, no matter which options are available on the page. Proceed to
Lesson 6 where you will create two Multiaxis Drill operations using two of the tool axis
control methods available for that toolpath type.

Introduction to Multiaxis Toolpaths—5: Tool Axis ControlOptions
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Multiaxis Drill Toolpath

Multiaxis drill toolpaths differ from other multiaxis toolpaths in several ways:

l Limited cut pattern selection: points, points/lines, lines, or features

l Restricted tool axis control: parallel to line, surface, or plane

l Fewer tip control options: point, projected point, or compensation sur-
face

The power of multiaxis drill becomes apparent on parts that containmultiple
holes with center lines pointing in different directions. Your multiaxis
machine is capable of drillingmany different holes with a single fixture
setup, saving time and increasing productivity.

Lesson Goals
l Open a part file and assign a machine definition.

l Create some Multiaxis Drill operations.

l Backplot the operations.

6



Exercise 1: Getting Started with Toolpath Creation
Assigning a machine definition is the first essential step in creating a toolpath. Setting
the graphics view to allow the easiest geometry selection plays a small part in visu-
alizing your work. This exercise guides you through the initial steps involved with cre-
ating a toolpath.

1. Open the part file Drill_Toolpath, which was provided with the tutorial.

2. If not loaded, select the default Mill metric machine definition.

Note: The default machine definition has rotary axes defined that allowmul-
tiaxis toolpaths. Load the machine definition of your choice as long as it sup-
ports 5-axis motion.

3. Set your graphics view to Isometric.

4. Activate shading if necessary.

5. Fit the geometry to the screen using [Alt+F1] or the Fit button.

Introduction to Multiaxis Toolpaths—6: MultiaxisDrill Toolpath
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6. Choose File, Save As, and save the part under a different file name. This pro-
tects the original tutorial file from being overwritten.

Exercise 2: Create a Multiaxis Drill Toolpath
1. From the Toolpaths tab, chooseMultiaxis, Drill.

2. Select Tool from the tree view pane.

3. Click Select library tool. The library defined in the machine definition opens.

4. Select the 10mm drill, and clickOK.

Adjust the tool filter settings as necessary to make tool selection easier.

5. Select Cut Pattern from the tree view pane.

6. Choose Points for the entity type.

Introduction to Multiaxis Toolpaths—6: MultiaxisDrill Toolpath



7. Select Peck Drill for the cycle and set the subsequent parameters.

Cycle selection determines the available parameters. Choose different cycles
to review the parameters.

8. Click Select points to return to the graphics window for point selection.

9. SelectWindow Points in the Drill Point Selection dialog box.

Introduction to Multiaxis Toolpaths—6: MultiaxisDrill Toolpath
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10. Create a window around the visible points.

The point geometry is on level 1.

11. ClickOK in the Drill Point Selection dialog box to return to the Cut Pattern page.

12. Select Tool Axis Control from the tree view pane.

13. Choose Surface for Tool axis control and 5 axis for Output format.

14. Click Select to return to the graphics window for surface selection.

Introduction to Multiaxis Toolpaths—6: MultiaxisDrill Toolpath



15. Select the surface as shown. Rotate the geometry as needed to allow selection.

The surface is on level 5. Use the Levels Manager to make it visible if neces-
sary.

Note: Manipulating the visible levels makes the selection process easier and
less susceptible to error.

16. Press [Enter] or click End Selection when done.

17. Select Collision Control from the tree view pane.

18. Set Tip control to Compensation surface.

ClickHelp for an explanation of the different tip control options.

Introduction to Multiaxis Toolpaths—6: MultiaxisDrill Toolpath

58



59

19. Click Select comp surfaces next to Compensation surface. The Toolpath/sur-
face selection dialog box opens.

20. Click Select to select surfaces in the graphics window.

21. Use the Levels Manager to make level 4 visible.

22. Select the surface as shown. Rotate the geometry as needed to allow selection.

23. Press [Enter] or click End Selection when done.

24. ClickOK in the Toolpath/surface selection dialog box.
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25. ClickOK to generate the multiaxis drill toolpath on the selected points.

26. Save your part file.

Exercise 3: Add a Second Multiaxis Drill Operation
1. In Levels Manager, turn off level 1, andmake level 3 visible.

2. From the Toolpaths tab, chooseMultiaxis, Drill.

3. Select Tool from the tree view pane.

4. Select the 10mm drill shown in the tool list.

5. Select Cut Pattern from the Tree View pane.
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6. Choose Points/Lines for the entity type.

7. The Cycle should still be Peck Drill. Set it if necessary.

8. Click Select points to return to the graphics window for point selection.

9. SelectWindow Points in the Drill Point Selection dialog box.

10. Draw a window around the visible points on the back side of the part.

Change the view to Back and rotate the geometry as needed to bring the
points/lines into view.
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Note: It is not necessary to select the lines, even though the entity type is set
to Points/Lines. The lines are automatically selected as long as they end on the
point.

11. ClickOK in the Drill Point Selection dialog box to return to the Cut Pattern
page.

12. Select Tool Axis Control from the tree view pane.

13. CheckOutput format to be sure it is set to 5 axis. Notice how Tool axis con-
trol is set to Points/Lines. The lines attached to the points are automatically set
as the tool axis control.

14. Select Collision Control from the tree view pane.

15. Set Tip control toOriginal point.
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16. Activate Tip compensation by selecting the checkbox. Set Break through to
2.0.

The break-through value determines how far the full diameter of the drill pen-
etrates beyond the selected tip control geometry.

17. ClickOK to generate the multiaxis drill toolpath on the selected points.

18. Save your part file.
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Exercise 4: Backplot the operations
1. Set your graphics view to Isometric.

2. In the Toolpaths Manager, click Select all operations.

3. Click Backplot selected operations in the Toolpaths Manager.

4. In the Backplot dialog box, select Display tool andDisplay rapid moves.
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5. ClickOptions in the Backplot dialog box.

6. Deselect the options shown and clickOK. This prevents your part from spin-
ning around andmoving out of view.

7. Click Play to begin the backplot of your toolpath.

8. ClickOK in the Backplot dialog box when you have finished reviewing the tool
motion.

You have now completed a multiaxis drill toolpath. While this is the simplest of the mul-
tiaxis toolpaths, care must be taken when selecting geometry, tool axis control, and tip
control methods. The differences between the control methods are subtle but can pro-
duce drastically different tool motion.
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Conclusion

Congratulations! You have completed the Introduction to Multiaxis Toolpaths tutorial!
Now that you have mastered the skills in this tutorial, explore Mastercam's other fea-
tures and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being
constantly developed, and we will addmore as we complete them. Visit our website,
or selectHelp, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful doc-
uments for your version of software in the Documentation folder of your
Mastercam 2018 installation.

l Mastercam Help—Access Mastercam Help by selectingHelp, Contents from
Mastercam's File tab or by pressing [Alt+H] on your keyboard.

l Mastercam Reseller—Your local Mastercam Reseller can help withmost ques-
tions about Mastercam.

l Technical Support—Our Technical Support department (860-875-5006 or
support@mastercam.com) is openMonday through Friday from 8:00 a.m. to
5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users
become familiar with basic Mastercam features and functions. Visit our web-
site, or selectHelp, Tutorials fromMastercam's File tab to see the latest pub-
lications.

l Mastercam University—Mastercam University, an affordable online learning
platform, gives you 24/7 access to Mastercam trainingmaterials. Take
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advantage of more than 180 videos to master skills at your own pace and help
prepare for Mastercam Certification. For more information onMastercam
University, please contact your AuthorizedMastercam Reseller, visit
www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find a wealth of information at www.-
mastercam.com. For tech tips and the latest Mastercam news, follow us on
Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam).
Visit our YouTube channel to see Mastercam in action
(www.youtube.com/user/MastercamCadCam)! Registered users can search for
information or ask questions on the MastercamWeb forum,
forum.mastercam.com, or use the knowledgebase at kb.mastercam.com.

Contact Us
For questions about this or other Mastercam documentation, contact the Technical
Documentation department by email at techdocs@mastercam.com.

Introduction to Multiaxis Toolpaths—Conclusion

68

http://www.mastercamu.com/
mailto:training@mastercam.com?subject=Mastercam University
http://www.facebook.com/mastercam
http://www.twitter.com/mastercam
http://plus.google.com/+mastercam
http://www.youtube.com/user/MastercamCadCam
http://forum.mastercam.com/
http://kb.mastercam.com/
mailto:techdocs@mastercam.com?subject=Documenation Question




ATTENTION! UPDATES MAY BE AVAILABLE.
PLEASE REFER TO MASTERCAM.COM/SUPPORT

FOR THE LATEST DOWNLOADS.
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